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0 VennMaker: Roots, Context and Fields of Application

In recent decades, the concept of social networks has gained wider currency among
various academic disciplines and areas of inquiry. Social network research generally
involves collecting data which describe patterns of relationships and support among
individuals, then analyzing them by employing concepts drawn from graph theory.
Generally, data involving contact partners within a personal (ego) network are collected
with the help of network questionnaires and then evaluated by means of quantitative

analytical software.

Collecting and analyzing these
* data (number, density, centrality

measures) has so far been carried

§ - * out wusing highly standardized
. - . o methodologies requiring
o . considerable effort from qualified
.l
4 research  staff.  Consequently,
- T ” these methods have their highest
{ value in the processing of very
i‘ “ * . .
Figure 1: Network of advisors at an academic large datasets. Owing to their

research center; based on a questionnaire survey,
visualized with the software program UCINET
(Schénhuth 2007a) they remain inaccessible to users

complex quantitative character,

in more action-oriented areas of network analysis, remaining ultimately bound to the

perspective of the detached researcher on the outside looking in.

As of late, there have been endeavors to develop methods that come "closer to the
actors, their perceptions, interpretations and structures of relevance" (Hollstein and
Straus 2005, translated from the German). Aimost all of these approaches are towards
a qualitative or "actor-centered

network analysis", a recently

o established frame which draws on

the "social convoy" model as

developed by Robert Kahn and
Figure 2: Method of concentric circles ("social convoy”) , o
support persons can be placed into different sections, Toni  Antonucci in 1980 for
according to their emotional importance as seen by the  4isplavin social support
interviewed persons (Kahn and Antonucci 1980) playing PP



structures. Because of their simple structure and the selective way in which the data are
collected, these models are limited in terms of informative value and empirical validity,

and therefore not without controversy (Diaz-Bone 2007).

Within organizational research and consulting, a branch has emerged in recent years
which visualizes organization members as involved in a common process suitable as a
template for analysis and interpretation. While these techniques are successfully
applied in consulting and development/aid processes both nationally and internationally,
they either come under criticism from academic circles due to their being neither

replicable nor representative, or they simply go unnoticed.

In a joint interdisciplinary project
of members of a cluster of
excellence at Trier and Mainz
Universities in Germany, we

have tried to overcome this

Figure 3: “Venn-diagram”: network of social actors in a gap.! Our team has developed
medium-sized business company in East Germany from software enables users to
a management perspective; size of circle = informal

decision-making power; distance =co-operational density  interactively  collect network
/ grade of actor- accessibility for the institution

(Schénhuth 2007b) relationship data from an actor's

point of view and render them
comparable and quantitatively analyzable by means of a intuitive graphical user
interface. While complex questionnaire procedures and specially trained staff have
dominated thus far, VennMaker allows lay users to map actors and their relationships in
an intuitive way and generate easily interpretable quantitative and qualitative data out of
it. The major benefit of this approach is that interviewees are able to visualize and
qualitatively evaluate their networks themselves while simultaneously reflecting on the
network structure and genesis together with the researcher, perhaps even considering

desirable alterations or the potential for transformation.

Our goal was to develop a tool that is efficiently in these kinds of participatory use

scenarios, while at the same time achieving scientific standards in generating and

1 The development of VennMaker draws on long standing experience in the development and application of
participatory research methodology (Schonhuth and Kievelitz 1995, Schénhuth et al. 1998, Schonhuth 2003,
2007), in visual data mining and graph drawing (Pohl et al. 2004, Pohl et al. 2006, Pohl 2007) as well as on
the professional experience of various other disciplines within the participating universities Trier and Mainz,
thereby broadening classical social network research with an innovative and unique methodological tool.



processing social network data. Not only is the entire process of generating the network
map documented digitally (the choice, positioning, and spatial distribution of actor
nodes, as well as the drawing of different relation categories, and the strength of ties
between them), but the statements regarding content and importance of social
relationships can be audio recorded during the interview and evaluated later via content
analysis methods. VennMaker also addresses the structure-agency problem in social
network analysis, as questions about the structural potential of a network (i.e. social
capital that could be drawn out of the structure) and the actual use of existing ties by an

actor can be posed and discussed on the spot.

From the vantage point of the social sciences, this has the potential to narrow the gap
between quantitative and qualitative network research. There have been many
developments in the area of “qualitative network analysis®, or “mixed methods-
methodology” (for Germany see Hollstein/Straus 2006), however, to our knowledge no
project has solved either the complexity problem in qualitative network maps or the
issue of interlacing qualitative and quantitative data in a satisfying way. Hopefully, given
some practical application, time will tell whether we succeeded in going one step further

with VennMaker.

Fields of Application

VennMaker holds an advantage in at least four different settings of network generation

and analysis:

First, VennMaker allows for participatory, process-oriented interviews, where the

client/interviewee and researcher/coach develop and discuss the network map together

in_a communicative process. A classic field of application would be a research or

coaching situation, where the researcher/coach would like to learn more about the
socio-strategic setting in which a person (or a group) acts, and the reasoning from the
point of view of the client(s). This “mental” network map then may act as a starting point
for any kind of probing on histories, current situations, or future prospects of this

network.

Second, the software allows for the realization of self interviews without the

researcher being present. An assistant system can guide the interviewee through all

stages of the mapping process step by step, with the help of preconfigured wizards.



This function makes sense when a_multitude of digital network maps with the same

research question must be processed, or in a series of computer-based interviews via

long distances. Picture a scenario involving the preparation of a conflict-workshop.

Here, stakeholders or experts could be requested to produce their personal map of the
actor constellation beforehand while being electronically guided from the preconfigured
VennMaker. Having evaluated the different personal views, the researcher could then
begin the workshop with the edited results, illustrating where there is common ground

and where there are perceived differences which will have to be negotiated.

Third, VennMaker is suitable for jointly generating strateqgic network maps of

organizational branches or projects (“strategic actor mapping”) in a group process. This

form of application fits nicely in situations where the elicitation and merging of different
actor views for joint action is a goal. An example would be the actor constellation and
network developed by the executive board of a medium—sized business company as
shown in Figure 3 — only that now it would be processed with VennMaker — either using
a Beamer (allowing everyone to take part in the visualized discussion), or using a more

cutting-edge interactive whiteboard like Hitachi’s Interactive Board FX Duo.?

Fourth, VennMaker allows for the user-defined amplification of graphical

representations, which can also be applied as a user friendly drawing instrument to

visualize network data that have been surveyved with other analytical methods

beforehand. This form of using VennMaker as a pure visualizing tool makes sense in all
forms of visual presentation of data analyses, be it as a basis for discussion or reflection

in working groups, or as visualized representations in lectures and publications.
“Venn” — what’s in a name

What does the name “VennMaker" mean? In Norwegian “Venn” means “brother”, but
this pun, though it makes sense, has not been the inspiration for our name. “Venn”, first
of is in reverence for the “Venn Diagram”, a tool used with much success in the
participatory appraisal of stakeholders in development contexts for the last 20 years. Its

originator was the English mathematician and philosopher John Venn (1834-1923).

To make sense of “Venn” in the way we use it with our software, you might read it also
as an acronym for “Very Energetic Nice Networks”. As developers. we wish all our users

this sort of experience when creating networks with VennMaker. In the end, this tool

2 Currently we are launching a project together with Hitachi Software Engineering Europe AG to implement a
multi-touch option into their whiteboard-series for VennMaker.



derives from the pleasure and gratification that people get when they see their own
social networks mapped out in such a way that they are able to “visit” it in a beneficial
communicative process together with the researcher/interviewer. This manual is

designed to guide you on this path as a competent, yet easy to read companion.

Michael Schoenhuth, Trier 5" of June 2009
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Introduction

The present manual serves as an introduction to the software VennMaker (Version 0.9.5
VIP). All available features of VennMaker are presented here step by step. The text is
divided into three big parts. Free network drawing, configuration and processing of
network interviews and exporting of generated data. At the end of this manual you
should be able to draw social networks, to configure and execute/perform interviews
and to export the obtained data with VennMaker. This manual is especially addressed to
readers who are acquainted with the fundamental terms of social network analysis.
However, that knowledge is not a prerequisite, especially for the free network drawing

mode.

1.1 Starting VennMaker

To be able to execute VennMaker, you need Java (Version 1.6.12 and later). You can

obtain Java free of charge, visiting http://www.java.com/de/download/.

Being able to draw social networks you have to install VennMaker first. Unzip the

VennMaker_0_9 5 VIP.zip file and into the new created VennMaker folder.

If you use Windows XP / Vista you may start VennMaker now double-clicking
“YennMaker.exe”. Should you have not installed Java on your computer, you will be

reminded to do so after having clicked VennMaker.exe.

If you use another operating system (Linux or Mac OS X for example), then you can

execute VennMaker directly starting VennMaker.jar.
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http://www.java.com/de/download/

Having started VennMaker the following window will open on your computer display:

W YennMaker B

EER -

VennﬂMaker

Free Metwork Drawing Configure Inkerview Perform Interview

Figure 4: VennMaker-'start'-window

The features that are hidden behind the three buttons “Free Network Drawing”,
“Configure Interview” and “Perform Interview” will be explained to you in the following

chapters.

By default English is the language of VennMaker. In the right upper corner you can

choose between “English” and “German’.

In the following chapter we will concentrate on the “Free Network Drawing” mode.
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2 Free Drawing of Digital Social Network Maps

Free drawing of digital network maps means that you are not subject to any restrictions
from the program concerning the design and generation of the network. So, you may
not only choose actors and relations freely from a range of default designs, but may
also configure and add new actor types and relations during a VennMaker interview

session if the situation demands it.

This mode makes most sense in exploratory interview situations, where the field
situation is yet unfamiliar or if maximum flexibility and responsiveness vis-a-vis the
proband / client's peculiarities and a minimum of comparability is requested. Typical for
the first scenario are hypotheses-generating research situations; typical for the second

would be consulting, counseling or coaching situations.

File Config About
L 2R 2D = HH | e
MNew Open Sawve Save Print Add Audio Compute | Image Actor
as.. Metwark data
Project Action Export
Action A Network

Actor types A

‘ OActor ‘
I:‘ Institut...
@ Fernale
s E%ﬂ

@ Male

Relation values ¥

—— Wesk

|_Network]

Figure 5: VennMaker in the “Free Network Drawing” mode

12



This chapter deals with those functions which are available in the “Free Network

Drawing” mode .

First, the different areas depicted in Figure 5 will be explained in more detail.

2.1 VennMaker Drawing Area

The big white surface area in the middle of the picture is called the “digital network
map”. In this area you can draw/place actors, relations, sectors, and concentric circles.
Every digital network map can be designed in different colors and be furnished with a

background image. We will come back to those features later.

Ego

In the default setting you will find the symbol of a human being in the center of the
empty map, which is labelled “EGO”. Ego by default stands for the person interviewed -
we deal with “ego-centered networks”. Renaming the center can also signify the project
or group out of whose point of view the network is designed. The Ego can also be

moved out of the center to become part of the whole network).

O

EGOD

Figure 6: Labeled Ego-symbol

In Figure 6 you see the Ego-symbol with the respective label. If you go over the Ego-

symbol with the mouse and press the right mouse button, the following drop-down menu

will appear:
)
EG v Fixed ego
Hide eqo
Enlarge
Shirink,

Fename actar

Edit comment

Figure 7: Drop-down-menu to execute changes for Ego
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If “Fixed ego” is activated, then the Ego-symbol can't be removed. If you choose “Hide
ego”, then the Ego-symbol will be suppressed. All relations leading from and to Ego are

also invisible and removed temporarily from the map then.

This operation is helpful, if Ego is part of a whole network, meaning, that there is no center, from
which a network is set up and seen, but any actor has his or her place within the net. It also fits for
Ego-centered interviews when for setting a stimulus you want to visualize only alteri-alteri
relations, that means the relations between the network partners of Ego (“how would the network
look like without Ego and his/her relations/ties?*).

If you want to uncover Ego again, just right-click anywhere on the map. You will get a
drop-down menu where you can click on “Show Ego”. After that Ego with all his/her

relations will reappear.

“Enlarge” boosts the Ego-Symbol, “Shrink” downsizes it, with every click one step
further. You can also use the mouse wheel for this action. Try which of the functionalities
fits you better. If you want to rename Ego, click the respective line named ,Rename

actor”. A box opens, where you can type in the new name.

Every actor, even Ego, can be endued with additional commentaries. For this purpose

choose “Edit comment”.

Legend

By default, in the left lower corner of the network map you will find an overlayed legend

with standard default settings (see Figure 8).

5@

[ ¢

—

Male
Female

—

Institutional actar

Ackar

Prone to conflict
— O

Simple

— - - Weak

Figure 8: Legend with default settings of the digital network-map

O

In the left lower corner of the network map by default you will find an overlayed legend

with standard default settings (see Figure 8).

The legend contains all actor types and relation types with their description. Figure 8
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shows the legend in the default setting. If you delete, modify or add an actor type or

relation type, the legend will be updated automatically.

The legend will be hidden by clicking on an unused space of the digital network map
with the right mouse button. A menu will open (see Figure 9) where you can choose

“Hide Legend”. Thereafter, the legend will be hidden.

v Fixed ego
Hide eqo
Hide Legend
Edit background...

Figure 9: Configuration menu of the digital network map

This also applies for displaying the legend. There is only one difference referring to the

menu. Now it contains a new menu item named “Show Legend”.

In this chapter you have learned to change some parameters of Ego as well as hiding
the legend of the digital network map. The following chapter will explain how to draw
other actors (resp. alteri/nodes) on the one hand and how to draw relations

(respectively ties) between the actors on the other hand.
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2.2 Drawing of Actors and Relations

On the left hand side of the digital network map you find the following default menu:

b

Action

b

Actor types

O ackar

Inskikut, ..

@ Femnale
@ Male

Relation values

£

Figure 10: Menu for drawing actors and relations

In Figure 10 three sections are shown: “Action”, “Actor types” and “Relation values”.

The upper section “Action” contains an “Undo” and a “Redo” button. If you make a
mistake while drawing the network you can adjust every step by clicking the “Undo”

button. The "Redo” button reverses the undone step.

You can use the undo and redo feature to recapitulate with your interview partner the process of

network generating.

In the central section “Actor types” the available actor types, their symbols and labels
are listed. The default configuration contains four actor types: “Actor”, “Institutional

Actor”, “Female” ,and “Male”.

VennMaker shortens the “Actor types” labels automatically to a eight letter word, e.g. “Institutional

actor” becomes “Institut...”.
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For example, if you want to draw an actor named “Peter”, firstly you have to select the
“Actor type” button named “Actor”. Secondly, you click on the position where the actor
should be drawn in the digital network map. Thereafter, VennMaker asks you to enter
the name of the actor. VennMaker will give notice if an actor with the same name

already exists.

If you want to choose an other actor symbol (e.g. male or female), just click on the appropriate

icon. Many other symbols are also available, how to load them see Chapter 2.7 and 3.

After you typed in the actor name, the actor type “Actor” will be shown as a circle in the
digital network map. The name of the actor is written underneath the chosen symbol

(see Figure 11).

()

Peter

Figure 11: Example of an actor type ,,Actor” with the name
,Peter”

An actor symbol can be moved by drag and drop the symbol to the favored place.

Clicking the right mouse button onto the actor, the following menu will be shown:

A

Peti Remove actar Fram this network

Remove actor From project

Enlarge

Shrink,

Rename actar

Change Actor Tvpe ]

Edit: comment

Figure 12: Menu for changing actor attributes

An actor from the present digital network map is deleted by selecting “Remove actor
from this network”. Afterwards, the actor symbol is placed in the left area “Available

Actors”’.

You remove an actor from the project by selecting “Remove actor from project”.
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“Enlarge” increases the size of the actor symbol and “Shrink” decreases the size.

You can also increase or decrease the symbol size if you move the cursor onto the

actor and turn the mouse wheel.

You may edit the size interval and symbol size directly in “Config” > “Image & Color” >
“Actor”. “Number of actorsizes” (Figure 13)means how many different sizes are
available and the table ,Size“ contains the different sizes (in pixel). “Size” relates to the
absolute / width of the actor symbols showing in the digital network map. You can

change the “Size” values by selecting and editing the corresponding cell inside the

table.
Background and Image Sectors and Circles
Actors View area

O tabel  apel right to actor

D Label over actor

Label under actor

,_
=]
[=3
i)

No label

O| O

Anonymize

]
L
(]

Number of actorsizes[S

Size
20
30
40
30
60

] Show all comments

0K || Cancel

Figure 13: Actor size window

The size values depend on your research question. Moreover, you have to keep in mind
that the actor symbol can be greater than the distance between two concentric circles.
At the time when the actor symbol overlaps two circles a correct interpretation will not

be possible.
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The example in Figure 14 makes the occurring problems clear concerning the use of
different actor sizes, and the use of the maximum number of sectors as well as the use
of concentric circles at the same time: Depending on the actor size an actor will overlap
the concentric circles. Keeping in mind while working with concentric circles and
sectors, the closer the actor to Ego is, the smaller will be the draw area in a sector and
a circle. Furthermore, the visual difference between actor sizes will be problematic when

using very small actor size intervals.

Therefore you will get the best performance if you choose in-between “interval not to

small and moderate actor size”. The Figure 14 helps to find a reasonable choice:

e o

Figure 14: Maximum range (1-10) and “praEz:/Tcal” actor sizes for different number of actor
categories (2to 5)

You can rename an actor / node by selecting “Rename actor”. That applies also for the

actor type which is changeable with “Change Actor Type”.
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Adding comments
For each actor comments can be added or edited by selecting “Edit comment”.

Comments are useful to capture some short attributes of an actor which are important for the

identification in the ongoing interview or for the validation at the end of the interview.

If you move the mouse courser over the actor VennMaker displays the comment after a short

delay.

“Config” > “Image & Color” > “Actors” > “Show all comments”. all comments are

constantly shown. If you select “Show all comments” again all comments will be hidden.

Drawing relations

By starting the “Free Network Drawing” mode the third section “Relation values” (see
Figure 10) will be minimized. You maximize this area if you click on the double arrows to

the right of “Relation values*” :

ke

Action

b

Actor types

Ackar

Institut, ..

@ Female
@ Male

Relation values

e

Weak

Simple

/\/)/

Skrong

Prone to conflick

/

Figure 15: “Relation values” menu
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In Figure 15 you can see in the section ,Relation values® four types of relations: “Weak”,
“Simple”, “Strong” and “Prone to conflict”. Each relation value is visualized with a

different line type.

If you click on one of the relation buttons (e.g. “Simple”) you are able to draw a relation

in the digital network map as follows:

Firstly, you click with the left mouse button on the actor from which the relation should
start. Secondly, you hold the button pressed while moving the cursor to the second
actor where the relation should end. Thirdly, you let the mouse button go. Finally, there

is a line drawn between the two actors.

If you move the cursor to a relation and press the right mouse button, the following

menu will be displayed (see Figure 16):

()
Anna
()
Pekter
\ Change relation bvpe 3
EGO Delete relation

Figure 16: Menu to edit the relation line

The menu item “Change relation type” changes the type of relation. That also applies for

the menu item “Delete relation” which erases the existing relation.

If you use directed relations you are able to change the direction by selecting “Reverse

Relation Direction” (how to create directed relations see chapter 2.8).

If you like to draw more then one relation type (“multiplex”) between the same two

actors the lines will be drawn automatically side by side.

You can add a comment for each relation by right-clicking on the particular line and

selecting “Edit comment”.
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Edit comment:

_hange relation type ]
% Heverse Helation Hireckion

EGO Delete relation

Figure 17: Adding a comment to a relation

The following chapters show how to modify, clone or create digital network maps.

2.3 Digital Network Map

Working with VennMaker the digital network map is the drawing area for creating the

social network itself.

2.3.1 Managing digital Network Map

Selecting “File” in the upper VennMaker menu a new multifunctional toolbar (also called

Ribbon) will be opened (see Figure 18).

Im Cu:unFig- : : —

T

=
My Qpen Save Save Prink Add Audio Compute Image Bckor
a5, Metwiork, = data

Project - 1] - Action Expork

Figure 18: Multifuncional toolbar

The menu is subdivided in three sections : “Project”, “Action” and “Export”.

Project

The “Project” section allows the creating of either a new VennMaker project, or the

opening of an existing project or the saving of the actual network map(s) in a project.

The VennMaker project itself contains the digital network map(s), the protocol of how

22



the networks were created as well as the links to the recorded audio files.

A new VennMaker project will be created by clicking on the “New” button. VennMaker
will ask you whether to create a new project respectively if you would like to close open

network maps. If you confirm a new project, it will be created.

You open a project by clicking on the “Open” button and choosing the corresponding

VennMaker file. “venn” is the extension of the VennMaker project filename.

The buttons “Save” or “Save as...” will store the project.

”

There is a slight difference between “Save” and “Save as...” If you choose “Save as...
VennMaker will ask you for the project name. If you want to save the project with the
same name (you have already chosen before) you just need to click “Save”. Thus,

VennMaker saves the project without asking for the project name again.

Action

The second section named “Action” contains amongst others the button “Add Network”.
After clicking on this button VennMaker displays a sub menu for creating an empty
network map (“Add empty network”) on the one hand and for cloning the actual network

map on the other hand (see Fig. 19).

File | Caonfig

= ¥ % | = ’ o— 1 EE

| o L) Y - |5 e k- ]

[ i = B = : i | | 5

T CIpEn Save Save Prink add Audio Campuke Image Ackar
as... Mekwork, = data

Project | Add empty network Expart
Clone network,
Arkinn Ead

Figure 19: Adding a new digital network map

The menu item “Add empty network” creates a new digital network map, whereas the
other menu item “Clone network” makes a copy of the actual network map. If you click

on one of these two menu items VennMaker creates the corresponding network map in
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a new pane (see Figure 20):

— . 1

Metwork, | Mew network

Figure 20: Digital network pane

You can change between the digital network map by selecting the corresponding pane.

To rename your digital network map, click on the respective tab by using your right

mouse button and choose “rename network”.

To remove a digital network map from your project, click on the respective tab at the

lower bar of VennMaker using your right mouse button. Then choose “delete network”.

After you have learned how to create, delete, and duplicate digital network maps,
please read the following chapter which presents how to provide an individual look of

the digital network map.

2.3.2 Customizing digital Networks

This chapter will explain how to modify the heading, the background color, the
background image, the size of the digital network map and how to add network maps to

the background.

You can modify the heading as follows: By default each digital network map contains a

heading:

a5,
Action

INECWOLE, %
Project

ion a
Network 2006
Unda Redo

))

or kypes

Bckar

Inskitut. ..

Figure 21: Heading of a digital network map

The heading is similar to the network map name (see Figure 20).
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You can repositioning the heading by right-clicking on the network map background:

—_—

add Audio Compuke
Mebwiork, w

JEN Save Save Print Image

Project Ackion Ex

B Network 2006

Redo

]

Hide ego
) Actor Hide Legend
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Figure 22: Changing the title position

The heading can be hidden (“Hide networkname”) or displayed in the left upper corner

(“Draw left’), the right upper corner (“Draw right”) or in the upper center (“Draw

centered’) respectively.

The following text illustrates how to adjust the background color, the background image,

and the size of a digital network map.

All functions mentioned within this chapter can be chosen in two ways: Either you click

on the free space of the network map by using your right mouse button and choose

“edit background” or you choose “config” in the upper menu of VennMaker before you

press ‘image & color” afterwards.

Finally, the following window should open by itself:
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Figure 23: Configuration window for digital network maps

Using a network map as a background image

By using more than one network map per project you can add some network maps to

current network map as an additional background image.

Example: In your project exists two network maps, one from the year 2006 and one
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from 2007 and you would like to show the differences between the two years.

The first step is to select the target network map where you would like to add the other
network map as a background image. In this example you select the network map from
the year 2007:

Male

Femnale
Institutional actor
Actor

——— Prone to conflict
Strong

— Simple

—  Weak

e 11

2006 | 2007 |

After this you right-click on the network map, select “Edit background...” and thereafter
in the “Background configuration™Dialog you click the “Add™-Button. Now, VennMaker

adds automatically all other network maps from the project in the “Network Map’-List:

¥ Background configuration x|

Backoround and Image | Sectors and Circles I fckors I Yiew ared I
~Background Mebwork Map

Mebwork Map

2006

Delete |

Figure 24: Adding network maps as background images

In this example the network map “2006” will be added to the list.
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After this you press the “OK™-Button and VennMaker will draw the network map “2006”
in the network map “2007”
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You remove a network map from the background as follows: You right-clicks on network
map and select the particular network map in the “Network Map” list. After this you press
the “Delete” button and then the “OK” button.

Changing the background color / Adding a background image

You can change the background color of the network map by clicking the “select’™-

button. Subsequently choose the background color.

If you like to use your own background image (for example a geographical map or

28



random images), click on “use background image” first and then choose your image by

using the “select™button.
The image must be saved as a jpg or gif image.

After the background image has been chosen, a preview is displayed (see Figure 26).

Background configuration

Figure 26: Preview of a background image

By using “position and size”, it is possible to fit the image into the digital network map in

various ways.
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“Do not transform image” means to leave the image in its original form. There will be no

size fitting.

“Zoom to fit” means to match the background image with the digital network map

referring to height and width.

“Preserve ratio” means to match the background image with the digital network map by

maintaining the aspect ratio.

“Preserve ratio (full size)” means to draw the full screen background image into the

digital network map by maintaining the aspect ratio.
The inserted background image refers to the current digital network map.
Maximizing the view area

(o] BaCheroundiconiEaration| L:a

Background and Image || Sectors and Circles | Actors [ view area |

Horizontal size: PDD v
Wertical size! 700 =

Figure 27: Change the size of your digital network map

Via the tab “view area” you can change the size of the current digital network map (see
Figure 27).

While drawing a digital network map, it is possible to hide the toolbar.
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Figure 28: Button to hide and uncover the toolbar

To hide the toolbar click on the button (see Figure 28) at the upper right corner of your

digital network map. By repeating, you can uncover the toolbar again.

2.4 Recorder — Record and Playback

With respect to qualitative research it can be necessary to record the spoken word in

order to analyze it at a subsequent date.
To record and playback the spoken word, VennMaker contains a recorder / player.

You can choose the recorder/player via “File” > “Audio”.

W Audiorecorder i (] S
................. .Rec ................. | ’ Plav I . Stc'p i II Pause I ‘ Slideshow

000:00 (0000000

Bctiviy |

Figure 29: Recorder

Provided a wired microphone, the recording process starts by clicking on “rec”. From

then on, every spoken word will be recorded.

Please check the quality of your microphone first. Use an external microphone if necessary.

The recording ends by pressing “stop”.

On the left, you can see the current time position. Enclosed in brackets, you see the

total time of recording.
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VennMaker automatically creates a recording file (.wav) in the VennMaker directory.

VennMaker memorizes the starting time automatically. If you like to hear or see the

interview again, the record file (.wav) needs to be placed in the VennMaker directory.

Attention: The recording files are saved in an uncompressed way. As for extended interviews,
therefore, recording files can quickly add up to 100-400 MB. Be sure to provide enough memory

space! Compressed audio formats are planned to be realized within a later version of VennMaker.

The playback starts by pressing “play”. The audio mode and the visualization mode are
linked to one another. During the creation of the digital network map all actions and
recorded speech are presented synchronously (for example, the drawing or movement
of actors/ notes, the creation of relations/links). Consequently, it is possible to
reproduce the entire interview including every spoken word and action while drawing the

digital network map in real-time.
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All user activities are displayed in a table: the first table coloumn “Nr.” contains the
activitiy number, the second coloumn “Time” the point in time of the activity and the third

coloumn “Activity” shows the name of the activity (see Figure 30).

¥ Audiorecorder _ O] x|

Orcc | wry | mow |CIEET| E Sideshow |

00:00:27 (00:06:19)
Hr. Time Ackivity

0. 00:00:00 (Creake and add new ackor “
1. 000007 I_hange actor bype
2, 000013 I_hange actor bype
3, no0:00:19 I_hange actor bype
4, 00:00:23 (Creake and add new ackor
E 00:00:26 (Creake and add new ackor
£, 00:00:28 (Creake and add new ackor
7. o0:00:32 fidd Relation
3 00:00:34 fdd Relation
A, 00:00:45 fdd Relation
10, 00:00:47 fdd Relation
11, 00:00:50 fdd Relation
12, oo:01:04 Clone network,
13, 00:05:47 Resize ackaors
14, 00:05:53 Maove ackar
15, 00:05:56 Maove ackar
16, 00:0e:00 Maove ackar
L7 00:0e:02 Maove ackar
14, 000603 Maove ackar
19, 00:08:05 Maove ackar
A1, 000606 Mowve actor o]
21, 00:0e.07 Maove ackar
22, 000810 Maove ackar
23, 000812 Maove ackar
24, 00:06:13 Mave actar |

Figure 30: Audio playback and the activity list

The playback can be stopped by pressing “Stop” or “Pause”. If you press “Pause” and

afterwards you press “Play” the playback starts at the same time position as before.

You can playback different activities by selecting these activity and pressing “Play”.

Then VennMaker will begin audio and visual playback at this position.
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On the left in the “Audiorecorder” window you can see the current time position.

Enclosed in brackets, you see the total time of recording:

® Rec ] =

00:00:27 (00:06: 19)

A further function is the “Slideshow”. The slideshow replays all activities with equal time

interval (2 seconds).

2.5 Initials Computations

You can execute initial computations in form of rates or density via “File” > “Compute”.

Results are presented within a separate window.
The results always refer to the current digital network map.

The illustrated rates contain the amount of actors per actor type, the amount of actors in
every single concentric circle and sector plus the total amount of actors in the digital

network map.

The density specifies the ration between the amount of drawn relations and the amount
of potential relations. Density can reach a value between 0 and 1. O signifies that no

relations are compounded. 1 signifies that all actors are totally networked.
Density is a measure related to the entire social network.

VennMaker distinguishes between networks with an Ego and networks without an Ego.
In the first case, the Ego is included into the computation of density. In the second case,
only the Alteri-Relations are considered. Usually, the density measure should be higher
when considering the Ego. The test person mentions familiar persons and is normally
not able to give broad information about Alteri-Alteri relations. Hence, the amount of
mentioned relations and potential relations is nearly the same. A more precise
description of useful measurements for social network analysis is illustrated in chapter
4.1.2.

You can save the results as CSV file via “Export’.
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2.6 How to Use Concentric Circles and Sectors

Actors attributes can be illustrated via both concentric circles and sectors. Those

functions are available via the “config” - menu (see Figure 31).

File | Config |
Circles Seckions |
& & |5 : =
v

Actor Relation Image
kvpes values Wil et 9 b D1 2343536 & Colar

Edit Biackground
Figure 31: Configuration Toolbar

You can use the regulator to adjust the amount of concentric circles and sectors.
Additional settings can be made via “Image & Color” > “Sectors and Circles” (see Figure
32).

W Background configuration x|

Background and Image  Sectors and Circles | fctors I Yiew area |

Mumber of sectors| 3

Transparency Jl

Sectaor Off amily _ Colar,..
Sectar 1{friend Calar...
Sector 2|c0||eague _ Color,.,

Sectar <| e fe]

i 4*_ G

SECHar | | ] (o]

Murnber of circlesl x|

Mame

Sarne aparkment
City
aunkry

OF Cancel

Figure 32: Configure concentric circles and sectors
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“Number of Sectors™ Choose the total amount of sectors.

“Transparency”. If you make use of a background image it can be helpful to adjust
transparent sectors. Otherwise they will cover your background image. You can use the
regulator to adjust the degree of transparency. The farther right you set, the more

transparent your sector appears.

“sector 0” - “sector 5” You can entitle every single sector. Those titles appear on the
digital network map. You can color your sector via the color-button next to every single

sector.

“Number of circles”. Here, you can adjust the total amount of concentric circles. There is

a maximum of 6 entitled circles in total.

2.7 Configure Actor Types

VennMaker offers a set of four actor types by default (female, male, neutral and
institutional). You can use them but you do not need to! It is possible to define your own
actor types or to modify existing actor types with VennMaker. Therefore, click “Config” >

“Actor types” (see Figure 33).

File | Config
& & Zircles Sections r‘.
- J e

v
Ackor Relation Image
bypes values D1 23436 N s e & Color

Edit Background
Figure 33: Configure actor types
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The following window should be opened by itself:

| Editsactor Y PEs @
Marne Image
fAckor IZircle.svg
Institutional actor Inskituk. swg
Female Female.svg
Male Male.swg
’ K I [ Mew bype I [ Delete type ]

Figure 34: Configuration window for actor types

The table contains two columns: “name” and “image”.

You can change an existing actor type name by clicking on the pursuant cell in the first
row. Then you can rename the cell. The actor symbol can be changed via the second
cell. If you click on the pursuant cell, a drop-down list opens where you can choose your

preferred actor symbol.
To add new actor types, choose “new type”.

You can delete actor types by choosing the pursuant actor type and clicking “delete

type”.

The actor type symbols are saved in the VennMakers subdirectory “/icons”.
You can create free symbols with open source vector graphic software like

“Inkscape”(www.inkscape.org).

If you want to add new symbols, you must save the svg file into the mentioned

directory. The new symbols appear in the drop- down list.
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2.8 Configure Relations

You can define your own relations or modify existing relations via “Config” > “Relation

”
values”.
[ E it =i b= 31
Marne Stroke
Weak, - —_— e — - — = — -
Simple
Skrong
Prone ta conflick
[ QK ] [ Mew Relation Yalue ] [ Delete Relation Value

Figure 35: Configure Relation Values

In Figure 35, you see the configuration window for relation values containing a table
with two columns. In the first column "name", you can change existing relation names
by clicking on the pursuant cell and rename it. The second column illustrates the
appearance of relations as lines. If you choose a cell, the following window opens by

itself:
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Figure 36: Configuration and Lines

"Stroke width" changes the thickness of a line. "Stroke Color" adjusts the color of a line.

"Dash type" determines the texture of a line.

Via "direction type", you can choose, if you like, directed (arrows) or undirected (lines)

relations.

You can see the pursuant setting as preview within the subjacent white space.

On our website http://www.vennmaker.com, you can find helpful tutorials containing

examples how to use the "Free Network Drawing” mode for explorative polls.
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2.9 Filter

Collecting of huge amount of social relations can result in complexity and faults. For this
reason VennMaker enables to set filter to hide or show relations. The filter shows all
relations from one actor to all adjacent actors and hide all other relations to non-

adjacent actors (see Figures 37-39).

- I
Remowe actar From this network

Remove actar Fram project

Enlarge
Shrink

Rename acktar
Change Actar Type »
EGD\ Edit camment

a

e

Figure 38: Activating a filter for actor “c”
Figure 37: Network without filter

EGD d

da

Figure 39: Network with filter

To activate the filter function you must right-click on the particular actor and select
“Filter” (see Figure 47). In this way a filter can be set for each actor. The filter has no
effect on the computation. You deactivate the filter by right-clicking on the actor and

selecting “Filter” again.
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2.10 Printing

To print the current network map, go to “File” and press the “Print” button:

In the print dialog you can choose the paper size and the paper orientation:

Page Setup
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If you press the “OK” button you can select the printer and the number of copies.

Click “Print’” and the printing will start.
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3 Configure and Performing an Interview

Due to comparative reasons a standardization of the interview framework is of an
advantage. First, interviews can be configured in advance. Second, performance of an
interview can be optimized according to test hypothesis using focused questionnaires.

Moreover, wizards will support an autonomous but guided interview mode.

3.1 Configure an Interview

VennMaker offers the “Configure Interview” mode, which will help to select the item,

type, order and time sequence of organizing an interview.

() ‘Configure Interview BEE

Ego|| Name Generator | Mame Interpreter | Time Sequence | Common options

[l Disable ego

If you disable ego the interview will only contain alteri.

[l Ego is moveable

[] size of ego is changeable

Ego's attributes:

Label Question Answer Type

Load | | Save | | Start Interview Exit

Figure 40: Main options to configure interviews

The “Configure Interview’-screen (Figure 40) is programmed to optimize the
performance of the designated interviews. In order to meet the need of a required
research design, there are certain ways for adjustment. Starting with entering items for
Ego, then the Alter name generators and the name interpreters can be described and

the time sequence can be specified.
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Finally, the design of the questionnaire can be customized using the common options

screen.
Configuring Items of Ego

Figure 41 shows the options to configure the items of Ego, such as location, symbols

and attributes.

(o) Gonfigure Intenview: EEEE

Ego|| Mame Generator | Name Interpreter | Time Sequence | Common options

[[] Disable ego

If you disable ego the interview will only contain alteri.

[J Ego is moveable

[[J size of ego is changeable

Ego's attributes:

Label Question Answer Type

MNew

Load | | Save | | Start Interview Exit
Figure 41: Data entry to select attributes and items of Ego
Set “Ego is moveable” and the usually center fixed Ego can be placed on the
VennMaker-screen freely. “Disable Ego” leads to the remove of Ego on the VennMaker-

screen. Even the “Size of ego is changeable” to resize Ego during an interview.

Within the “Ego’s attribute”, “New” items can be configured using “Edit” and existing

items can be erased with the function “Delete”.
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) Gonfigurel Interview Environment: |

Configure attributes for ego

Attribute

Marme of attribute [ l

Question

Related question | |

Answer type

Predefined Answers [J Allow multiple selections

Mew...| | Edit... Delete

[ Allow free answers

Unit

Allow "No Answer" Minimal value:

Allow "Don't know Maxirmal value:
Ask on |Start of interview | v

oK Cancel

Figure 42: Data entry to configure items of Ego

Choosing “New” leads to a data entry screen (see Figure 42) to configure the items.
Insert the name of the item into the “Name of attribute’-field. Formulate the interview
question using the field extensions of “Related question’-field . Select given answer
types regarding the “Answer type” part of the screen. “Predefined Answers” helps you to
prepare categories of supporting questions. “New...” creates new answers, “Edit..”

corrects predefined answers, and “Delete” removes existing answers from the list.

If your test person shall not choose from predefined categories but answer freely

instead, you can select “allow free answers”.

Afterwards you can choose between “text” and “numerical’. “Text” permits to enter any
characters while “numerical” permits to enter numbers only. Furthermore, you can
determine the type of numbers (“Units” as meters, pounds, dollars or number of

persons). Via “minimal value” or “maximal value”, you can restrict the range of numbers.

You can determine two kinds of answer denial via the options “allow ‘no answer” and
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“allow ‘don’t know’”.

The time position for asking a question in the interview is determined via the drop-down

menu “ask on”:

“Start of interview”: The question is posed at the beginning of the interview before the

digital network map will be drawn.

“Adding to network”: The Question is posed as soon as the Ego is shown on the digital

network map.

"End of interview”: The question is posed after network drawing at the end of the

interview.

The setting will be assumed by clicking on “OK”. The question will be displayed in the

“‘Ego’s attributes” list. You can edit the question via “edit”.

3.1.1 Configure the Name Generator

Ego | Name Generator | pame Interpreter | Time Sequence | Commen options

General question for name list

Max., Number of Alteri

0 =

Load | | Sawve | | Start Interview Exit
Figure 43: Input fields for the name generator
If you choose the tab “name generator”, the input mask for the name generator will be

opened by itself (see Figure 43).
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The primary function of the name generator is to frame the social network. You can
define further questions for all persons (alteri) surveyed with the name generator via

‘name interpreter” (see Chapter 3.1.2).

“‘Max. number of alteri” specifies the maximum amount of Alteri the test person can
enter. “0” signifies no restrictions. The test person can enter Alteri as many as she or he

likes in the name generator list.

3.1.2 Configure the Name Interpreter

The tab “name interpreter” opens an input mask within which you can enter, edit and

delete different name interpreters (see Figure 44).

e Gonfigure Intenview: SEE

Ego | Mame Generator | Name Interpreter | Time Sequence | Commen options
Alter (node)| | Relation (tie)

Mon-relational Attributes

Label Question Answer Type
MNew
Load | | Save | | Start Interview Exit

Figure 44: Input fields for determination of different name interpreters

Name interpreters are questions about alteri attributes. The alteri are surveyed by the

name generator. You can ask for relational and non- relational attributes.

If you like to list non-relational attributes, choose the tab “alter(node)” and then “new”.
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After pushing the button, a new input mask opens by itself (see Figure 45). You can
enter any label for your item into the box “Name of attribute”. The label will not be

shown during the interview.

You can formulate the question for any item within the “Related question” line. This

questions are displayed during the interview.

Within the sector “Answer type” it is possible to determine different survey methods for
every question. The test persons can choose from a set of predefined answer

categories or they can enter their answers freely.

Predefined answers are determined in the field “predefined answers” (see Figure 45).

(o) ConfigurelInterview Envitanment E)]

Configure attributes for alters

Attribute

MName of attribute [ l

Question

Related question | |

Answer type

Predefined Answers [ Allow multiple selections Visual Mapping |Mone ~

New...| |Edit... Delete [ matrix

[ Allow free answers

Unit
Allow "No Answer" Minimal value:
Allow "Don't know" Maximal value:

Ask on |Star‘t of interview | v

oK Cancel

Figure 45: Input fields for Alter attributes

You can define an answer for the predefined answers field via the button “New...”.
‘Edit...” opens a list with all predefined answers for editing. “Delete” deletes the

selected answer from the list.
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If you choose “Allow multiple selections”, the test person is able to select multiple
answers. If you do not set the checkmark, the test person can only give one answer

during the interview.

You can choose elements for visualizing the answer categories via “Visual Mapping’.
The test person chooses the respective answer. VennMaker links the answer category
with a visual element. For example: If you pose a question about alteri’s sex, the answer

will be assigned to a respective symbol onto the digital network map.

Hereby, answer categories can be linked not only with a symbol type but also with the
symbol size. Additionally, predefined answers can be assigned to relations-lines, sectors
and concentric circles. The respective menu items are “actor type”, “actor size”,

1Y

“relation type”, “sector” and “circles” within the drop- down list “visual mapping”.

Via “actor type”, the predefined answers are linked with different actor symbols. “Edit”
permits to change the actor types: Choose the respective answer category and click
“Edit”. A window with a drop-down menu opens by itself. You can select your preferred
symbol and then click “OK”. The file name for the symbol in the actors’ symbol list has

changed.

The actor type symbols are saved as .svg files(svg = scalable vectot graphics) in the VennMakers
subdirectory "/icons". You can create free symbols with open source vector graphic software like
"Inkscape" (www.inkscape.org). Further information about free .svg editor tools can be found on
www.svg.org. If you want to add new symbols, you must save the .svg file into the mentioned

directory. The new symbols appear in the drop-down list.

“Actor size” permits to link the answer categories with different actor symbol sizes.
Therefore, you can define an individual size (pixels) via “Visual Mapping”. Every line in

the “Visual Mapping” window is linked to the respective answer category.

“Relation type”: If your question measures a relational attribute, you can assign different
line types to the respective answers. The line types are illustrated in the window “Visual

Mapping”. You can edit them via the “Edit” button.

“Sector™ Single sectors can be linked to answers via this menu item. The answers are

assigned to the sectors clockwise.

"Circle": Single concentric circles of the digital network map are connected with answer

categories through this menu item. On the digital network map the proband can see the
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respective, given answer in the corresponding concentric circle. For this, the answers

are assigned outgoing from the center of the circle to the respective circle.

The collecting of the Item by given answers can be handled differently in the
interrogative dialogue. If you activate “Matrix”, for example, the proband will be offered a

spread sheet during the interview (see Figure 46).

) VennMaker, &)
Venn
OMaker
What kind of advice do the Person give? -E-:
|help in emotional lend
household | [Problems money no answer don't know
Anna ] [ ] ] | [
Hans %] 4] %] O [
Peter [ [ 5]

Frau Schmidt & -]

Figure 46: Input matrix in the Interview mode

In the first column all Alteri and in the first row the given answers are listed. In the other
cells there are small clickable boxes. If the proband clicks one of these boxes, he or she
chooses the respective answer category for the respective Alter. The advantage of this
kind of questioning is that the proband can see all Alteri with the response spectrum and
is able to select the answer category quickly.

Another design of the interrogative dialogue uses so-called "Buckets". Here, the
proband can pull the Alteri in Buckets / fields (see Figure 47).
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™ VennMaker

How often do you speak with the person about personal matter?

Vem“"‘Maker

Hans
Anna
oy
_ Prewvious
never sometimes frequently
Frau Schrmidt Peter

MNext

Figure 47: Buckets in the Interview mode

Each bucket represents one given answer category. If you have chosen "Visual

Mapping"> "Actor Size", then buckets are used in the interrogative dialogue.

If you like to get the question answered independently — meaning, without
predetermined categories — then activate "Allow free answers". Here, one can choose

between "text" and "numerical".

"Text" permits the input of any character, while "numerical" permits only numerics. "Unit"
predefines the unit (for example, dollar, and liter) and "Maximal value" and "Minimal

value" predefine the upper limit and lower limit of the numeric.

nii

Via "Allow No answer"“ and "Allow Don't know" the proband can refuse the answer and

give the reason of this refusal at the same time.
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3.1.3 Setting the Time Sequence of the Interview

If you choose the tab "Time Sequence”, the following template will open:

e Configure Interview HE=E

Ego | Name Generator | Name Interpreter | Time Sequence|| Cornmon options
Indirect Marme Generator Mew text wizard
Ego questions
Ask actor importance
Alteri questions (start)
Ask relations
Draw network
Alteri questions (end)

Ego questions (end)
Sawve and exit

Up

Down

Load | | Save | | Start Interview Exit

Figure 48: Time Sequence Template

In the left section the respective actions are listed following chronological order. The
order can be changed, while clicking the respective entry and afterwards clicking on
"Up" or "Down". "Up" will shift the entry one row upward. This means, that the
respective action in the interview takes place earlier. "Down"” will shift the entry

downward, the action takes places chronologically later.

“‘New Text Wizard” will create a new text wizard. A text wizard is a simple text window
which the proband can see during the interview. It is used to create additional
information and offers help and guidance for the proband, e.g. giving instructions. At the
beginning of the interview, for example, a text wizard “Welcome to the interview!” could
appear or at the end of the interview one can read “Thanks a lot! Please, click on 'next'

to stop the interview”.
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3.1.4 General Settings

In the tab "Common options” you may choose the size of the digital network map as

well as the respective language.

3.1.5 Loading and Saving of the Interview Configuration

You can load an existing interview in the configuration menu by choosing “Load".
Interview-configuration files will have the file extension "vennEn". You can save the
settings which you have determined in the interview configuration menu by clicking

“Save".

Via “Start Interview” you can switch over to the interview mode and test your settings.

“Exit” will finish the configuration mode.

The following chapter explains how to conduct a preconfigured interview in the “Perform

Interview” mode.

3.2 Conduction an Interview

You can conduct a preconfigured interview by choosing the mode “Perform interview”.
After clicking the button (see Figure 4) you are requested to select a preconfigured

interview file. Interview files will have the ending “vennEn”.

Depending on the configuration of the interview the respective interrogative dialogues

(see Figure 49) will appear.

By clicking "Next" and “Previous” you are able to navigate between the dialogues -pre
and -back. If you change to the digital network map you will see a “Next” button on the

left side with the respective question.
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Figure 49: lllustration of the name generator dialogue in the Interview mode

At the end VennMaker stores the interview result in a file in the VennMaker directory.
The file name consists of a random, six-digit number with the file ending “venn”. You can

load this file in the “Free Network Drawing” mode for further analyses as well as for
exporting.

How to export conducted networks with VennMaker you will learn in the following
chapter.
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4 Export of Data

The following chapters give an outline how to anonymize and export collected data with
VennMaker. The chapters imply that you already have recorded a network. How to

record a network and to conduct interviews, is shown in chapter 2 and chapter 3.

4.1 Export of digital Network Maps

VennMaker offers the possibility to safe digital network maps as picture files as well as
CSV files.

4.1.1 Saving digital Network Maps as Picture file

You shall start VennMaker in “Free Network Drawing” or “Perform Interview” mode.
Here, it is possible to safe the actual selected network map via “File” > “Image” as

“png”-picture file.

How to safe your network data in VennMaker — processing them with other programs,

as OpenOffice Calc, Excel or SPSS — you will learn in the next chapter.

4.1.2 Saving digital Network Maps as CSV files

For the processing of your network data VennMaker offers the memory function in the

so-called CSV-format (CSV= “Comma Separated Values”) via “File” > “Actor Data’.

You can freely choose a name to safe your files. At least five CSV files will be saved:

ego, alter, relations, adjacency matrix files and network characteristics files.

All files will have the filename extension “csv’. Additionally, VennMaker is adding

specific file names:

In the ego file “EGO_ Name.csv” all data for Ego will be saved. Which question was
answered in what way, as well as x- and y-coordinate and several network values. The
first column contains the Ego-ID, which is a combination of the actor name and a unique

number. In the anonymization mode the actor name is omitted.

The alter file “ALTER_Name.csv™ includes information about Alteri: the actor name, in
which sector and circle the actor is located, x- and y-coordinate and a few network

values. The first column contains Ego-ID to allocate Alteri to Ego. The second column
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includes the respective, uniquely Alteri-ID, which consists of the actor name and a
number. In the anonymization mode the actor name is omitted. If the actor is located

outside of sectors or circles, then it is coded with ,-1% in the respective column.

In the relation file “RELATON_NetworkMapNumber.csv’ one can find information
about delineated relations. Here, the data are arranged in a matrix form. The first
column and the first row contain the actor-IDs. The direction of relation is defined as

follows: from the actor in the respective row to the actor in the respective column.

The characteristics of relations are saved as string, while non-existent relations are
coded with “0”.

The network characteristics files “Compute NetworkMapNumber Name.csv’
contains different types of frequencies, e.g. number of actors, number of actor types,

number of of actor types per sector and circles and so on.

In the adjacency matrix file ,ADJAZENZ_ NetworkMapNumber Name.csv® the
respective adjacency -matrix is saved. Existing relations contain ,1%, while not-existing

ones are coded with “0”.

NetworkMapNumber means the network map number, which depends on the quantity of
used network maps. If only one digital network map is used in VennMaker, then only
one relation- and overall network characteristics file exist with the network map number
“1” (e.g.: RELATION_1_Name.csv).

Name: is the name of your VennMaker project (see Chapter 2.3.1).

The following three charts are showing how VennMaker is transferring the graph in

Figure 50 into two different matrices.
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Figure 50: Example of a socia?ﬁétwoflg a_esigned with VennMaker

The digital network map in Figure 50 is to read as follows: Ego is placed in the center. In
this example the concentric circles are signifying the spatial proximity of the Alteri to
Ego. The closer Alter is to Ego on the network map the closer Alter is living near Ego.
The Alteri are distinguished between two actor types, “male” and “female” as well as into
the different symbol sizes. The bigger the actor in size the more frequent Ego is meeting
the actor. The colored lines are visualizing the respective type of relation between Ego-
Alter and Alter-Alter.

An example: the female actor B is living in the near neighborhood of Ego. Ego and actor
B occasionally are meeting each other. Actor B and Ego have a friendly relationship,

while actor B and actor C have a conflict relationship with each other.

Figure 51 is showing a relation matrix, which is saved in the RELATION.csv file. The
matrix includes the equivalent number of rows and columns. The first column and the
first row are containing the notations of actors. In the first cell of the first column and row
one can find the name of the digital network map, in our example “network”. The matrix

has to be read as follows: Actor H has a “friendly relationship” with Actor Actor I. The
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direction of the relation always starts from the respective row to the respective column.
Because we have an undirected graph — the relations are proceeding in both directions
—, also the matrix is symmetric, which means that the from-top-left-to-bottom-right matrix

diagonal can be mirrored on the lower matrix diagonal (cf. Jansen 2006, p. 100).

In our example the cell “Actor H — Actor I” has the same size as the cell ,Actor | — Actor
H* namely ,friendly relationship“. Undrawn relations are coded with “0”. Behind the
name one can find a number which shall ensure that actors with the same name can be
distinguished, e.g. Actor Hand ID 1 = “Actor H_1".

Network  Actorl_2 ActorA_7 ActorH_1 ActorB_5 ActorD_8 ActorE_9 EGO_0 Actor G_3 ActorF_4 ActorC_6

Actor_2 0 0 friendship 0 0 cporr?frl‘i‘; friendship  friendship  friendship 0
Actor A_7 0 0 0 0 0 0 undef. 0 0 0
relationship
ActorH_1 friendship 0 0 0 0 rel:tri‘gf;'hip friendship  friendship  friendship 0
Actor B_5 0 0 0 0 0 0 friendship 0 0 cpc:rc\)i[;igt
ActorD_8 0 0 0 0 0 0 friendship 0 0 0
prone undef. . . undef. undef.
Actor E_9 conflict 0 relationship 0 0 0 friendship relationship relationship 0
EGO_0 friendship __YNdef giondship  friendship  friendship  friendship 0 friendship  friendship __ndef.
- relationship relationship
Actor G_3 friendship 0 friendship 0 0 rel:tri‘g:’;'hip friendship 0 friendship 0
ActorF_4 friendship 0 friendship 0 0 rel:tri‘g:;hip friendship  friendship 0 0
ActorC_6 0 0 0 prone 0 0 undef. 0 0 0
conflict relationship

Figure 51: Example of a social network, depicted in terms of a relation matrix

In Figure 52 one can see an adjacency-matrix, which is saved in ADJAZENZ.csv. An
adjacency-matrix is a matrix with an equivalent number of rows and columns; existing

relations are coded with “1”, while not-existing relations are coded with “0”.

58



Network Actor I_2 ActorA_7 ActorH_1 ActorB_5 ActorD_8 ActorE_.9 EGO_0 ActorG_3 ActorF_4 ActorC_6
Actor 1_2 0 0 1 0 0 1 1 1 1 0
Actor A_7
Actor H_1
Actor B_5
Actor D_8
Actor E_9
EGO_0
Actor G_3
Actor F_4
Actor C_6

Figure 52: Example of a social network depicted in terms of an adjacence matrix
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Actor A (3rd row) has got only a relationship with one person, namely with Ego (column
8), while Ego (column 8) has relations to all the other actors. Actor relations to oneself
are undocumented; therefore, the from-top-left-to-bottom-right located matrix diagonal is
coded with “0”.

The Compute.csv file contains the following:

Actortype_male
Actortype_female
Circle_-1

Circle_0

Circle_1_same apartment
Circle_2_neighborhood
Circle_3_same city
Circle_4_Germany
Circle_5_abroad
Sector__-1

OO O O N O N O O O W o

Sector__1 _family member

N

Sector__2 non family member
Density (with Ego) 0.44
Density (only Alter) 0.31

Figure 53: Example of a Compute.csv file

The first row includes the name of the respective network map, in our example

“network”.

The following rows contain the total number of Alteri and the single type of actors from

the cited example. The rows that contain “Circle” visualize the respective frequency of
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actors per concentric circle. “Circle_-1"is representing the area outside the concentric
circles. “Circle_0” is representing the area in which Ego is located. In both areas Alteri

have not been drawn; therefore, they have the frequency value “0”.

“Circle_1...”-"Circle_5...” refer to the default distances. For example, there are 5 Alteri
who are living at the same place and only 2 Alteri who are living in neighborhood with

Ego.

The lines which are labeled with “sector” include the frequencies of actors per sector.
“Sector_-1” is representing the area outside the sectors. Besides the mentioned
frequency calculation VennMaker offers additional analytical network measures: density,

degree, indegree and outdegree.

Density: The density is representing the degree of connectedness of the network. The
density of a network is defined by the ratio of the existing relations to the number of
categorically possible relations (cf. Jansen 2006, p. 94). In VennMaker the drawn rows
are considered as relations. The row “Density (with Ego)” (Figure 53) contains density
value, in which Ego and its relations are considered; while the value of density in
“‘density (only Alteri)” is calculated for the Alteri and its relations. Which of the both
values are important for you, is depending on your research question (cf. McCarty and
Wutich 2005).

Figure 54 and Figure 55 contains the attributes of Ego and the Alteri from the cited
network example. The containing degree-values are signifying the following: the degree
of an actor gives information on how much the actor is embedded in a network. If Ego

has direct relations with two actors, then Ego has a degree of “2”.

Indegree and Outdegree: Indegree and Outdegree are simple measures for prestige,
popularity and social support (cf. Jansen 2006, S. 96). Indegree is representing the
number of in-going direct relations of the particular actor; while outdegree is measuring
the number of out-going direct relations. In VennMaker the drawn rows are considered
as relations. Moreover, it is important to point out that the calculation of indegree- and
outdegree is only possible for directed relations. If one uses undirected relations then

the values are the same for in- and out degree and describe the degree.

To compare the outdegree and indegree values between different networks the values
must be normalized. The score is between 0 and 1. The higher the value the higher the

degree.
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id_Ego Xx_Network y_Network Indegree_Network  Outdegree Network  Size Network
EGO_O0 530.0 436.5 9 9 60

Figure 54: Ego attributes of a network example

How often do you
speak with the What kind of relationship exists

person about What kind of advice do the Where does the Person Is the person  between you and the Sector_in_ Circle_in_ Indegree_N Outdegree_
id_Ego id_Alter Alter_Type x_Network y_Network personal matter? person give? live?_Network female or male? person_Network Network  Network etwork Network
EGO_0 ActorH_1 male 416.0 268.0 somtimes help in household same city male friendship 0 3 5 5
EGO_0 Actorl_2 female 708.0 347.0 frequently househzﬂﬁe‘:noﬁonal same city female friendship 0 3 5 5
problems_lending money
EGO 0 ActorA 7 male 495.0 631.0 frequently emotional problems same city male undef. relationship 1 3 1 1
EGO 0 ActorB 5  female 436.0 537.0 somtimes help in household neighborhood female friendship 1 2 2 2
EGO 0 ActorD_8 male 714.0 615.0 somtimes help in household Germany male friendship 1 4 1 1
EGO 0 ActorE9  make 605.0 189.0 somtimes emes’i'lg',']%"‘:; money Germany male friendship 0 4 5 5
EGO 0 ActorG_3  female 534.0 235.0 never help in household same city female friendship 0 3 5 5
EGO 0 ActorF_4 male 615.0 253.0 never help in household same city male friendship 0 3 5 5
EGO_0 ActorC_6 male 399.0 4730 never help in household neighborhood male undef. relationship 1 2 2 2

Figure 55: Alter attributes of a network example

Closeness (Incloseness and Outcloseness): Closeness is a function of geodesic
distances from the actor to all other direct or indirect connected actors. The geodesic
distance is the shortest length between two nodes. If the geodesics increase in length,

the centrality of the actor also increases (vgl. Wasserman and Faust 1994, S. 184f.).

The closeness centrality can also be calculated for directional relations.

Proximity Prestige: Proximity Prestige measures how proximate the actor is to the
actors in its influence domain. Proximity is defined as closeness that focuses on
distances from one actor to all other direct or indirect connected actors. The minimum
value of the Proximity Presitge is 0, which means the actor is unreachable. The
maximum value is 1, if all actors are adjacent to the actor (vgl. Wasserman and Faust
1994, S. 203f.)
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Indegree_| Outdegree_ | IndegreeStd_ OutdegreeStd_ | InCloseness_ | QutCloseness_ ProximityPrestige_ | OutClasenessStd_
Metwork | MNetwaorl Metwark Metwork Metwork Metwork Metwark Metwork
1 1 0.5 0.5 3 3 0.667 0.667
2 2 1 1 2 2 1 1

Figure 56: Part of an Alter.csv file

How to work with exported data, you will learn in the following chapters.

4.1.3 Import of Data into OpenOffice Calc or Microsoft Excel

After starting OpenOffice Calc or Excel you can load the respective CSV-file via ,New" >

,Open“ or you can open the file via double-click.

In OpenOffice Calc you will be asked to set a separator. Here, you shall choose

,Semicolon® and then click on ,OK".

4.1.4 Import of Data into SPSS

In this subchapter you will learn how to load a CSV file. After starting SPSS (version 15
or greater) you click on “File” > “Open”. Here, you change to the folder in which you
have saved the CSV file. After that you choose as data-file “All files (*.*)”. Select the file

CSV fuile you want to import.
After that SPSS is starting the Import text wizard:
In step 1 you handle everything like it is set and only click on “Next”.

In step 2 please set the question “How are your variables arranged?” to “Delimited” and
for “Are variable names included at the top of your file?” click “Yes” and then choose
“‘Next”.

In the step 3 you shall clarify that the first case is located in the second line, that “Each
line represents a case” and “All of the cases” shall be imported. After that please click

on “Next”.

In step 4 you set the question “Which delimiters appear between variables?” to
“‘Semicolon”. Please deactivate “Space” and activate “None” in “What is the text

qualifier?”. In the data preview field of SPSS all data shall be presented correctly.
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In step 5 you can set the specification for the variables. Therefore, please click the
particular column in the data preview field and choose the respective data format. If you

have determined all characteristics of variables please click on “Next”.
In step 6 you will finish the import by clicking the button “Finish”.

SPSS is now loading the data; if necessary you have to determine afterwards, if the
respective variable is “numeric” by type. This is possible in the variable view in the

column ,Type“.

4.1.5 Import of Data into Ucinet

Please start Ucinet (Version 6.217) and click the button “Matrix spreadsheet”. In the
opened window click on “File” >”Open” and go to the particular folder, in which you have
exported the digital network map with VennMaker as CSV files. Afterwards you shall

choose the file type “CSYV files”.

Usually all CSV files are listed. Here, choose the respective adjacency file and click on
“OK”. Subsequently please make sure that the number of rows and columns is equal in
‘Dimensions”. Finally, please safe the data via “File” > “Save as” as “UCINET 4-6

dataset”.

4.1.6 Visualization of Network Graphs with NetDraw

In the next step please start NetDraw (Version 2.0) and load saved dataset-files:
“File” > “Open” > “Ucinet dataset” > “Network”

The following options have to be selected:

File format: Ucinet (*.##h)

Type of data: 7-Mode Network(s)

Ignore reflexive ties: should be activated

Ties have values > 0.0

Please choose the file which you have saved in Ucinet via “..” and click “OK*. Now the

network will be drawn and further calculations can be carried out.
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4.2 Anonymization of collected Data

Often it is necessary to modify collected data to prevent identification of the respective

proband or Alteri.

Therefore, VennMaker offers an anonymization function which allows substituting actor
names by numbers. An anonymization can be carried out in both “Free Network
Drawing™- or “Perform Interview” mode. Click “Config” > “Image & Color”. After that
please click the button “Anonymize” in tab “Actors”. Accordingly numbers instead of the
name of actors will be shown. Anonymization will be done for all digital network maps
and encompasses both saving as picture file as well as export as CSV file. In
VennMaker it is anytime possible to display the name of actors by choosing another

label button in the tab "Actors”.

Data protection and informed consent

Data that are collected in social network analysis are often sensitive personal
data. VennMaker allows to elicit official and non-official network data of persons
and institutional actors, and this in settings where often unequal power
relationships and resource distribution prevail. As with any other powerful
instrument VennMaker could be used for various legal and non-legal purposes.
The inventors are aware of this problem and make security and protection of
personal data a prime development goal. Together with the acceptance of the
license the user of VennMaker is obliged to use the software only with the
informed consent of those who share their social networks during this process,
according to existing legal rules of confidentiality and data protection. Any data
produced and stored have to be anonymized or encrypted, in a way, that it is not
possible to draw traceable personal information of any kind by third parties that
otherwise could not be drawn from official sources. As a user of VennMaker you
are obliged to follow the guidelines of good scientific practice (cf. Universitat Trier,
2002) and especially to obtain approval (“informed consent®) of the probands (cf.
Bortz and Doring 2006, p. 44).
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5 Copyright Informationen

5.1 VennMaker License

Copyright © 2007-2008 by Schoenhuth, Pohl, Gamper and Stark

© 2009 by Michael Schoenhuth, Markus Gamper, Martin Stark. All rights reserved.

This disclaimer governs your use of the software VennMaker. By using VennMaker, you
accept this disclaimer in full. If you disagree with any part of this disclaimer, you must
not use VennMaker. Unless otherwise stated, we or our licensors own the intellectual
property rights in the VennMaker software. Subject to the license below, all these

intellectual property rights are reserved.

License

Permission to work with VennMaker for educational and research purposes only is
hereby granted, provided that this copyright notice and the original inventor's names
(Schoenhuth/Gamper/Stark © 2009) appears on all copies and supporting

documentation.

For any other uses of this software, in original or modified form, including but not limited
to distribution in whole or in part, and especially for all forms of commercial use specific

prior permission must be obtained from the copyright holders.

The software, models and documentation shall not be used, rewritten, or adapted as the
basis of a commercial software or hardware product without first obtaining appropriate
licenses from the copyright holders. We make no representations about the suitability of

this software for any purpose.

It is provided ,as is” without express or implied warranty.
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Data protection and informed consent

VennMaker allows to elicit official and non-official network data of persons and
institutional actors, and this in settings where often unequal power relationships and
resource distribution prevail. As with any other powerful instrument VennMaker could be
used for various legal and non-legal purposes. The inventors are aware of this problem

and make security and protection of personal data a prime development goal.

The user of VennMaker is obliged to use the software only with the informed consent of
those who share their social networks during this process, according to existing legal
rules of confidentiality and data protection. Any data produced and stored have to be

anonymized or encrypted, in a way, that it is not possible to draw tracable personal

information of any kind by third parties that otherwise could not be drawn from official

sources.

Limitations of warranties and liability

Whilst we endeavour to ensure that VennMaker is running properly, we do not warrant
its completeness or accuracy; nor do we commit to ensuring that VennMaker remains

available or that it is kept up-to-date.

To the maximum extent permitted by applicable law we exclude all representations,
warranties and conditions relating to VennMaker and the use of it (including, without
limitation, any warranties implied by law of satisfactory quality, fitness for purpose

and/or the use of reasonable care and skill).

Nothing in this disclaimer will exclude or limit our liability for fraud, for death or personal
injury caused by our negligence, or for any other liability which cannot be excluded or

limited under applicable law.

Subject to this, our liability to you in relation to the use of VennMaker or under or in
connection with this disclaimer, whether in contract, tort (including negligence) or

otherwise, will be limited as follows:

(a) to the extent that VennMaker and the information and services are provided free-of-

charge, we will not be liable for any loss or damage of any nature;

(b) we will not be liable for any consequential, indirect or special loss or damage;
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(c) we will not be liable for any loss of profit, income, revenue, anticipated savings,

contracts, business, goodwill, reputation, data, or information.

Revision

We may revise this disclaimer from time-to-time. The revised disclaimer will apply to the
use of VennMaker from the date of the publication of the revised disclaimer on our

website http://www.vennmaker.com/. Please check this page regularly to ensure you are

familiar with the current version.

Part of the text is drawn with permission from:

http://www.website-law.co.uk/disclaimer.html

5.2 Licenses of used Libraries

Xstream
Copyright (c) 2003-2006, Joe Walnes
Copyright (c) 2006-2007, XStream Committers

All rights reserved.

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer. Redistributions in binary form must reproduce
the above copyright notice, this list of conditions and the following disclaimer in the

documentation and/or other materials provided with the distribution.
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http://www.vennmaker.com/

Neither the name of XStream nor the names of its contributors may be used to endorse

or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS ,AS IS* AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Batik SVG Toolkit
Copyright 2009 Batik SVG Toolkit

Licensed under the Apache License, Version 2.0 (the ,License®); you may not use this

file except in compliance with the License. You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the
License is distributed on an ,AS IS* BASIS, WITHOUT WARRANTIES OR
CONDITIONS OF ANY KIND, either express or implied. See the License for the specific

language governing permissions and limitations under the License.
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Tango Desktop Project

The color palette is public domain. The icon theme is also available as public domain
since the 0.8.90 release. While you are not obligated to, we would appreciate if you
credit the project if you chose to use the icon theme or derivative artwork in your project
by linking to our website. This will help to strengthen the awareness of the style

guidelines. Thank you.

http://tango.freedesktop.org/Tango_Desktop_Project

SwingX

GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007

Copyright © 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document,

but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and
conditions of version 3 of the GNU General Public License, supplemented by the

additional permissions listed below.
0. Additional Definitions.

As used herein, “this License” refers to version 3 of the GNU Lesser General Public

License, and the “GNU GPL” refers to version 3 of the GNU General Public License.

“The Library” refers to a covered work governed by this License, other then an

Application or a Combined Work as defined below.

An “Application” is any work that makes use of an interface provided by the Library, but
which is not otherwise based on the Library. Defining a subclass of a class defined by

the Library is deemed a mode of using an interface provided by the Library.

A “Combined Work” is a work produced by combining or linking an Application with the
Library. The particular version of the Library with which the Combined Work was made

is also called the “Linked Version”.

The “Minimal Corresponding Source” for a Combined Work means the Corresponding
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Source for the Combined Work, excluding any source code for portions of the
Combined Work that, considered in isolation, are based on the Application, and not on

the Linked Version.

The “Corresponding Application Code” for a Combined Work means the object code
and/or source code for the Application, including any data and utility programs needed
for reproducing the Combined Work from the Application, but excluding the System
Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being
bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a
function or data to be supplied by an Application that uses the facility (other than as an
argument passed when the facility is invoked), then you may convey a copy of the

modified version:

* a) under this License, provided that you make a good faith effort to ensure that, in
the event an Application does not supply the function or data, the facility still

operates, and performs whatever part of its purpose remains meaningful, or

* b) under the GNU GPL, with none of the additional permissions of this License

applicable to that copy.
3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that
is part of the Library. You may convey such object code under terms of your choice,
provided that, if the incorporated material is not limited to numerical parameters, data
structure layouts and accessors, or small macros, inline functions and templates (ten or

fewer lines in length), you do both of the following:

* a) Give prominent notice with each copy of the object code that the Library is

used in it and that the Library and its use are covered by this License.

* b) Accompany the object code with a copy of the GNU GPL and this license

document.
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4. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together,
effectively do not restrict modification of the portions of the Library contained in the
Combined Work and reverse engineering for debugging such modifications, if you also

do each of the following:

» a) Give prominent notice with each copy of the Combined Work that the Library is

used in it and that the Library and its use are covered by this License.

* b) Accompany the Combined Work with a copy of the GNU GPL and this license

document.

» c) For a Combined Work that displays copyright notices during execution, include
the copyright notice for the Library among these notices, as well as a reference

directing the user to the copies of the GNU GPL and this license document.
* d) Do one of the following:

* 0) Convey the Minimal Corresponding Source under the terms of this
License, and the Corresponding Application Code in a form suitable for,
and under terms that permit, the user to recombine or relink the
Application with a modified version of the Linked Version to produce a
modified Combined Work, in the manner specified by section 6 of the GNU

GPL for conveying Corresponding Source.

* 1) Use a suitable shared library mechanism for linking with the Library. A
suitable mechanism is one that (a) uses at run time a copy of the Library
already present on the user's computer system, and (b) will operate
properly with a modified version of the Library that is interface-compatible

with the Linked Version.

* e) Provide Installation Information, but only if you would otherwise be required to
provide such information under section 6 of the GNU GPL, and only to the extent
that such information is necessary to install and execute a modified version of the
Combined Work produced by recombining or relinking the Application with a
modified version of the Linked Version. (If you use option 4d0, the Installation
Information must accompany the Minimal Corresponding Source and

Corresponding Application Code. If you use option 4d1, you must provide the
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Installation Information in the manner specified by section 6 of the GNU GPL for

conveying Corresponding Source.)
5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a
single library together with other library facilities that are not Applications and are not
covered by this License, and convey such a combined library under terms of your

choice, if you do both of the following:

* a) Accompany the combined library with a copy of the same work based on the
Library, uncombined with any other library facilities, conveyed under the terms of

this License.

* b) Give prominent notice with the combined library that part of it is a work based
on the Library, and explaining where to find the accompanying uncombined form

of the same work.
6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU
Lesser General Public License from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems or

concerns.

Each version is given a distinguishing version number. If the Library as you received it
specifies that a certain numbered version of the GNU Lesser General Public License “or
any later version” applies to it, you have the option of following the terms and conditions
either of that published version or of any later version published by the Free Software
Foundation. If the Library as you received it does not specify a version number of the
GNU Lesser General Public License, you may choose any version of the GNU Lesser

General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future
versions of the GNU Lesser General Public License shall apply, that proxy's public
statement of acceptance of any version is permanent authorization for you to choose

that version for the Library.
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